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 What does this application enable you to do? 
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Overview 

 

Figure 1: This OECD eXplorer layout is based on three dynamic multiple-linked and coordinated views 

(Choropleth Map Layer, Scatter Plot and dynamic Histogram). This analysis shows the indicator “Population 

65+ yrs” for all OECD TL2 regions and represents the colour scale. The Scatter Plot shows the relation 

“Population 65+ yrs” vs. “Population 0-14 yrs” (vertical axis). OECD eXplorer opens with a preloaded Story 

with selected indicators and displaying all four OECD continents in the Choropleth Map. All views are 

synchronized and the same data can be analysed simultaneously in each view. The Story’s metatext is shown in a 

Story Panel. A continent is selected by a click on the cross icon in each map view. Splitters can adjust the size of 

any of the views. Preloaded indicators to be analysed are selected in the combo boxes attached to the Colour 

Legend and Scatter Plot axes. The bottom view is shared by the Histogram, Parallel Axes Chart (PAC) and Time 

Graph (only temporal data). Menu or use the lower splitter. Three OECD regions are selected and highlighted 

in all three views.  

Statistics eXplorer is a web compliant application that enables the statistics visualization of socio-
economic information at national or detailed territorial level providing clear insight on regional 
differences and performance within a country and comparison of different areas across countries. 
Statistics eXplorer enables users to explore simultaneously spatial, temporal and multivariate data 
from multiple perspectives, to discover interesting relationships, to share their incremental 
discoveries with colleagues and finally to communicate selected relevant knowledge to other users.  

Statistics eXplorer is composed of GeoAnalytics Visualization (GAV) components facilitating a 
broad collection of dynamic visualization methods developed and integrated for use with the Adobe© 
Flash© and Flex© development platform. In this respect, Statistics eXplorer represents a leading edge 
tool being adapted to the Internet and used as a web-enabled toolkit. 

 The statistical dataset contained in OECD eXplorer (figure 1) is the OECD Regional database 
which contains yearly time-series for around 50 indicators on demography, economy and labour 
market opportunities, environment, social issues and innovation related activities for more than 
2,000 regions of the OECD countries. Regions within each OECD country are classified on the basis of 
two territorial levels: the higher level (TL2) consists of 337 large regions (figure 1) while the lower 
level (TL3) is composed of 1,708 small regions.  
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In order to detect trends and gain understanding and knowledge within the data, it is convenient 
to view it through a number of different visual representation methods, each of which is best suited 
to highlight different patterns and features. OECD eXplorer’s user interface layout is divided into 
three coordinated and linked views (figures 1): Choropleth Map, Scatter Plot and Dynamic Histogram. 
These views are separated by interactive splitters (figure 1), allowing the user to scale the sizes of 
individual views. The Scatter Plot share views with the Data Grid and Table Lens, while the Histogram 
shares with a Parallel Axes Chart (PAC) and the Time Graph (only for time animation).  

Coordination between views uses a novel data linking method where the visualization 
components use the same data model and colouring scheme. A selection made in one of the 
visualization components propagates to all the others. 

 

      

 

Figure 2: An overview of the various methods available in Statistics eXplorer V4.x  
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Load data in OECD eXplorer (see also Load external data for your Statistics eXplorer) 

 

 

Use the menu Load Indicator to load data. 
First select territorial level of regions (small 
or large) in the right menu then select data 
for a “single” year, “latest” available year or 
“time span”. Data are here organised into 
categories (Demographics, Economic, Social 
and Innovation). Select indicators by clicking 
in a box. The (i) button gives detailed 
information about indicators, e.g. 
Population by Age includes 3 indicators age 
classes 0-14, 15-64 and 65+. 

 

 

 

For a single year…  

All indicators of the OECD regional database and their associate data are preloaded in OECD eXplorer 
and can therefore be accessed immediately. To access all the data, use the top menu 
Indicators>Load Data window. First select “territorial level” mode (TL2, TL3 or TL3+NOG), then select 
“latest data”, “single year” or a “time span” for animation mode. Data that is available depends on 
your choice and will be listed in the left column organized according to topics Demographics, 
Economic, etc. Load as many indicators as you want (previous choices are saved). If you switch from 
one territorial level to another previous choices are lost and you must select data from start again. 

…Or a time span of years 

In time span (animation) mode, you can select “minimize time span” where selected indicators 
must have data for all years or alternative “maximize time span” where selected indicators can have 
“no data” for certain years. The icon next to the indicator’s name shows the available years. 

 1) Indicator data are preloaded; 
 2) Data can be input from a client local data file (the format is 
described in the Help menu “How to load your own data”; 
3) A Story can include external data (not available in the 
preloaded data source). Stories built from temporal data are 
marked with a “movie” icon; 
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…And add your own external data 

OECD eXplorer also supports to import your own data using an Excel-like format: Unicode. 
Additional data can be loaded using the top menu Indicators> load your own data window. The 
additional data must, of course, be related to the OECD regions and maps. A detailed description of 
the data format can be downloaded from the Help menu. Note: If you want to combine OECD 
regional data with your own data then you must FIRST load the OECD regional data and THEN read 
your own related data. 

 

 

Example data set, for the Italian NUTS 2 (TL2) regions, 5 indicators, all Meta information filled in.  

OECD eXplorer will use this to display the data in a more complete way. 

 

Example data set for time data. See more information in separate documentation that can be accessed in 

Help 
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Choropleth Map View 

 

Figure 3: The Choropleth Map View including the important dynamic colour legend, associate control panel 

for selecting a suitable colour map and a Map layer settings panel. 

The Choropleth Map component is based on our layered map architecture (figure 4). Each region 
is coloured according to the current assigned colour map indicator. The toggle button in the top left 
map panel is used to turn on/off the Google Map layer. You find more controls in the Option Menu. 

Basic pan and zoom functions are available through mouse left-click and drag (pan) and mouse 
wheel scroll (zoom) respectively. Alternative you can use the pan-zoom GUI panel in the upper left 
corner. 

 The actual indicator value for a region is displayed by moving (hovering) the mouse above it 
(tooltips). By clicking with left mouse button on a region, it becomes selected (highlighted) in the 
map but also in all other views. You can select (highlight) several regions by clicking with the mouse 
on the region and pressing the CTR button on the key board at the same time. 
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Figure 4: Map layer architecture.  Statistics eXplorer has 

several map layers Country border layer, region shape 

layer, pie chart layer and optional a Google Map layer. 

The map layers are set in the menu Options>Map Layer 

Settings. The opacity for each layer is controlled here, 

which means that you can decide the colour intensity for 

each layer. 

 

 

 

Select countries to be explored 

 

 

 

 

 

 

 

Figure 5: Selected countries Germany, Czech Republic, 

Austria and Switzerland are explored for TL3 regions.  

Select individual countries to explore. Menu 
Options >Choose Regions Group. Mark countries to 
be explored:  Austria, Germany, Czech Republic etc. 
Only the selected countries will be coloured in the 
map and displayed in the Scatter Plot and PAC. The 
colour scale is calculated only for the selected 
regions. This option is functional when external is 

available for a single or several countries.  
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Colour Legend and Colour Scale 

 

Figure: The Colour Scale Legend plays an important role in Statistics eXplorer and provides many features 

and options that can well influence the visual result. A divergent colour scale is applied as default together 

with a statistical method based on percentiles to calculate five suitable class values based on the selected data 

(figure A and B). 50% of the regions with lower values are coloured in blue and regions with higher values in 

yellow-red. Alternative linear calculation based on Min and Max values are applied (figure C). The class 

value sliders can be moved dynamically or by clicking on a class value box (figure D), the user can assign 

preferred exact values. The top cross with arrows glyph allows a user to move colour legend. 

Colour coding is a fundamental technique for mapping data to visual representations with three 
fundamental goals: 

1) To serve the purpose of the map based on its intended audience, use and data; 
2) To communicate the map’s information in the most efficient manner, with simplicity and 

clarity; 
3) Intuitive interactive tools to enable users to adapt colour scales according to their needs; 
 
  Colour coding is often provided in a limited way only or it is not used effectively. Furthermore, 

adapting colour scales automatically by applying a simple minimum-maximum-scaling often results in 
visual representations of different views on the data which 
cannot be compared with each other. This chapter describes 
how appropriate automatic or user defined colour coding 
schemes can enhance the visual exploration of spatial or 
spatial-temporal data. From a collection of schemes (see 
figure to left) the user chooses the most appropriate one 
(sequential or diverging) with respect to the users’ 
visualization goal. The default scheme is a scientific proven 

diverging blue-to-red colour scale  . 
The Statistics eXplorer scalar colour mapping area (colour 

legend) is used to assign colour to each scalar value in the 
dataset. This will allow you to, for example, assign a blue 
colour to regions with a low “population growth rate” while 
assigning red to regions with higher growth rate. An example 
of this interface is shown in figure 3.  
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The selection of the indicator that controls the colour map can be done in three ways: 1) through 

the combo box next to the colour legend (figure 6A “Select Indicator”); 2) the top icon  to the left 
of the colour legend (“Colour Scale Selection”);   3) clicking on the indicator name in the headers of 
Parallel Axis Chart (see more below). 

By assigning an indicator for the colour scale associated with the colour legend, all views will be 
coloured accordingly. The region with the highest data value will get the colour specified at the top 
of the colour range, and the lowest will get the bottom colour. All regions in between receive a 
scaled colour based on their respective values. Statistics eXplorer’s standard approach of the 
visualization scales the colour map according to value density based on percentile calculations (figure 
6B), which means that value ranges with a high amount of regions receive a larger range of colours to 
help distinguish them.  

The default colour scale representing the values associated with an indicator is considered within 
the regional data set. Perceptual distances within a colour scales reflect distances in the data. 
Moreover, a colour scale could reveal whether a selected indicator contains zero values by creating 
intervals. The first (top) icon (6A) initiates the “Colour Indicator and Scale” (6D), where the user can 
choose a diverging colour scale (blue-to-red or red-to-blue etc) or sequential. 

 The fourth icon from the top (percentile distribution)  splits the data into six intervals 
or bins based the 5th, 25th, 50th, 75th and the 95th percentiles (figure 6B and result in 7A). 
This provides a better automatic distribution of colours related to the data based on an 
accurate statistical method and the visualization is improved in a way that differences 
between values can be more easily detected. Colour scale values can also be adjusted 
dynamically by moving the handlers. The percentile and corresponding data values are 
shown to guide the user when moving any of the handlers attached to the colour scale 
legend (figure 8B).   

The user can also switch to 25th, 50th and 75th or 10th, 50th and 90th percentiles by 
moving the mouse over the percentile icon to the right and an arrow will appear giving 

the user a choice.  

The third icon  uses a linear interpolation based on the minimum and maximum values and 
divided into six classes with equal distance, this is effective if the structure of the data is accurately 
represented and for time animation. However, linear interpolation leads to problems if the values of 
an indicator are not uniformly distributed (e.g. if outliers are present). In this case a wide range of the 
colour scale represents a small number of values and the majority of values are placed in a narrow 
range of the colour scale. See result in 7B. 

The scale value boxes are sliders and can be moved dynamically. The user can also click on the 

scale value  to assign a user preferred value - a box is shown for editing the 
value. This method is appropriate to assign, for example, a "zero value" in a diverging colour scale 
(figure 8a).  

The last icon “user scale” (6D) gives the user the possibility to assign own discrete user scale 
values that don't reflect distances in the colour scale, i.e. the user has control of both the colour 
distribution and scale values for maximum customization (see figure 8c). The user clicks (6D) on each 
scale number and assign a new value.  This is especially useful for indicators with values around “0”, 
e.g. population growth when “0” can be assigned and give an exact split between negative and 
positive values. 



11 

 

 

Figure 7: A: percentile 5
th

, 25
th
, 50

th
, 75

th
 and 95

th
; B: linear colour scale; 

The dynamic handlers (sliders) in the colour legend can be moved to assign preferred class values.     
Figure 8a shows the resulting map with indicator “population growth rate”. The user has first 
assigned 0.0 to the centre point (where blue change to yellow/red) in the diverging colour scale. 
Double click on the class value to be edited and a box pops up, assign a new value then OK. Next, the 
dynamic handlers are moved to new suitable class values -1, -0.5, +1 and +2. Regions with high and 
low “population growth rate” can more easily be distinguished.  

 

Figure 8a: Population Growth Rate for 1995-2005.  A diverging (blue-to-red) colour scale based where the user 

has assigned the class value 0.0 to the break point between blue and red. This means that regions with negative 

growth value will be blue and positive yellow-to-red. 
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Figure 8b: The fourth icon from the top assign a discrete colour scale (instead of a linear). 

 

Figure 8c: A special new feature in V3.7 is the 

colour legend boxes  , that can be 

turned on in the menu views->map widgets->bar 

colour legend. The standard colour legend 

component can now be moved with this icon   

across the entire Statistics eXplorer layout. A good 

comparison is achieved between the boxes and 

discrete colour scale set by the icon . The new  

 in the colour indicator and 

scale tool panel  allows a user defined colour 

scale (beyond the predefined colour scales). The 

colour scale in the set panel that is initiated 

corresponds to the default top colour scale (see 

figure to the left).Each coloured box represents 

a colour along the colour scale axis – you click on a 

colour box and select a start and end colour for each step along the colour scale and new smooth colours 

are calculated and applied in the colour legend. 

Click here to apply a 
legend with discrete 
values at equal distances 



13 

 

Statistics eXplorer Optional Google Map layer 

 Statistics eXplorer optional supports a Google Map layer that integrates various types of Google 
Maps (Street, Satellite, Hybrid, Terrain) with the OECD eXplorer shaded regional map and country 
border layer (figure 3). The Google Map layer with, for example, city names for Western Europe and 
TL3 regions (figure 9) can make the identification of a geographic location easier. However, Google 
Map requires more memory (RAM) and can also reduce interactivity and slow down time animation. 
We recommend therefore that you avoid this version if you have a computer with little or modest 
memory and performance. However, a powerful computer could have many benefits from the 
integrated map layers. 

 

 

Figure 9: OECD eXplorer for EU with and without Google Map street layer 
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Selection Details View 

Once one or more regions have been selected in the map or in the scatter plot, you can view the 
values for all the indicators referring to those regions. The “Selection details” view is activated with 
View>Selection details in the Menu. The values are also updated in Time Animation Mode. 

 

 

Figure 10: GDP Growth Rate for TL3/NUTS3 regions.  The Detailed Selection Information Panel is used to 

display data value for selected (highlighted) regions. This map highlights Alicante and all indicator values can 

be viewed in the Selection Panel. This panel is also updated for every time step in a time animation. 
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 Scatter Plot 

The Scatter Plot is a graph that displays how two indicators in the data set relate to each other. A 
region is represented by a dot at the intersection values for the two indicators chosen on the X-axis 
and Y-axis. The plot also shows two extra dimensions through the use of colour, which is shared 
between all views, and through the size of each dot, so the number of indicators simultaneously 
analysed is increased to four. 

To change which indicators to be displayed, use the three combo boxes (figure 11a), one for each 
axis and one at the top for dot size. The maximum dot size can also be adjusted through a bar on the 
right hand side. Hovering (tooltips) above a dot (region) will display detailed information, and clicking 
on the dot will select (highlight) the region in all views along with the Scatter Plot. 

You can select (highlight) several dots (regions) by clicking with the mouse on the dot and 
pressing the CTR button on the key board at the same time.  Alternative, click on one or several 
regions in the map and the corresponding dots will be highlighted in the Scatter Plot. 

 

Figure 11a: Scatter Plot displays four dimensions horizontal-axis, vertical-axis and size of scatter point. The 

colour of the dot (4th dimension) is controlled by any indicator choice selection tool. One slider controls dot 

area scaling for individual dots.  

Zoom in Scatter Plot 

A zoom function in Scatter Plot is initiated by holding down left mouse button and at the same 
time draw a rectangle (figure 11b). Regions inside this rectangle will be zoomed in and axis scaling 
and annotations are changed accordingly (right image). Zoom can also be initiated by using the 
middle mouse scroll. This alternative zoom function also depends on the position of the mouse.  
Zoom can be cancelled by a click on the 1:1 icon in lower left corner of the Scatter Plot. The zoom 
function can also be used in animation mode to highlight regions close to each other.  
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A 
Figure 11b: Zoom function in Scatter Plot. In the left image a zoom window is selected by a mouse movement 

with must button pressed. The right image shows the resulting zoom window. 

Zoom can also be initiated after filter operations have been used in the colour legend or PAC 
Panel (see more about colour legend and PAC below). By clicking on the Icon in the lower left corner 
a zoom is performed based on the remaining regions in the scatter plot after a PAC filter operation.  

 

Figure 11c: A zoom can also be applied with a mouse scroll. In this scatter plot the mouse is placed in the lower 

left corner – All bubbles are zoomed towards the right (see blue arrow in left plot). 
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You can make a rectangular selection in the Scatter Plot to highlight all regions inside the 
rectangle simultaneously in all views. Press CTRL when you make this selection. 

 

Figure 11d: Select a rectangle with CTRL pressed – the inside regions will be highlighted. 

 

 

Figure 11e: Scatter Plot in Time Animation mode (temporal data). Four regions are highlighted and you can 

follow the movement of a selected region (coloured dot) by its trail line. Six line types are available – after this 

all lines will become a continuous black line. Dots move and colour is updated through time steps. 
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Dynamic Histogram (Bar Chart) 

The new dynamic Histogram (bar) chart is placed in the bottom view sharing space with the PAC 
and Time graph. This graph can be a significant visualization complement, coordinated and linked 
with the map and scatter plot (and the other views). Histogram can be displayed in both vertical and 
horizontal mode. Histogram is based on a focus & context method using fisheye technique meaning 

that more bars than available space can be displayed. The bottom slider  
controls where focus should be along the axis. In figure 12a, the focus is placed to the left of the axis 
while in figure 12b, the focus is in the middle. Moving the focus slider will then place new bars in 
focus. Bars not in focus will be displayed as thin lines – visible in the background and giving the user 

an idea of all bars in the data set. Clicking on the Focus button  will change the histogram 
to use standard scroll technique along the axis. Histogram view has two hidden control panels to the 

left of the view “Histogram settings” and “View settings” (figure 12c). With the crop button  the 
scale of the axis is controlled.    

 

Figure 12a: Dynamic histogram with two indicators “population age 65+” and “population age 0-14”.The 

individual bars are given a default value that can be changed in the Histogram Settings panel. Up to four 

stacked bars (indicators) can be displayed together. 

  

 

Figure 12b: Histogram with one indicator “population age 65+” and with colour allocated to the same 

indicator. 

Open 
panel 
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Figure 12c: The two Histogram panels give the user a 

detailed control of the attribute settings in the chart. In the 

panel “View settings”, you can use the button  

 to choose between vertical and 

horizontal bars. The function of each individual button and 

slider are self explanatory and shall not be described in too 

much detail here but left to the user to experiment with these 

controls. For example, the slider   controls 

scale values on the axis and  controls the 

space allocated for regional names which sometimes can be 

very long. 

 
 
 
 
 

 
 

 
 

Figure 12 d:  displays multiple indicators (up to four) as stacked bars or single 
bars. Here we have three indicators showing age population for 0-14, 15-64 and 65+ that should add 
up to 100%. We can see the difference between using stacked or single bars for comparison. 
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Figure 12e: Example of a horizontal histogram using focus & context view. The slider is now placed 
along the vertical axis while the crop slider along the horizontal axis. 

 

Figure 12f: In this histogram the colour refers to a second indicator “GDP Growth rate”. We can now 
correlate “age 65+” against this second indicator. We see immediately a strong correlation between 

high % of 65+ and low rate for GDP Growth rate. The Focus button  is now 
set to OFF and slider here scrolls along the bars showing 61 bars. You may also notice another new 
feature – the colour legend can be moved in the Statistics eXplorer layout. 
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Parallel Coordinate Plot (PCP) View Indicators 

 

Figure: The profiles for three regions are compared. The lines are displayed with three different line types to be 

able to distinguish between the region profiles. The lines in the background are coloured by the indicator axis 

“Population aged 65+”. Inquiries and filtering (removing) regions can be performed using range sliders 

positioned at the top and bottom of the axes. 

Statistics eXplorer introduces this well-known visualization method from the Information 
Visualization area called  Parallel Coordinates Plot (PCP).  PCP is a proven visualization technique for 
identifying trends and cluster in many scientific environments but has not been used in statistical 
visualization. PCP enables visual representation of spatial multivariate indicator data and hence could 
become an important mechanism in Statistics Analytics. Each country is represented by a string (line) 
passing through the “parallel axes” intersecting each axis at a point depending on the indicator value 
of region.  Each axis represents a single indicator. The highlighted strings forms a visual 
representation of the characteristics of one region (Niger etc.). 

 

Figure: A PCP representation of a data set with 4 indicators for France only, where “population age group 

65+%” represents the coloured indicator. Each axis represents a single indicator and regions are represented 

by coloured strings (“population 65+ %) passing through the axes. PCP facilitates exploration and analysis of 

the relationships between several indicators and regions. Negative relationship, for example, is shown between 

indicator "Population 15-64" and "Population 65+". Similar profiles of selected regions can be seen by 

highlighting". Paris, for example, is highlighted in a black thick line. The green thick line represents the mean 

value for each attribute and allows a comparison between actual and mean value. Each column in the Data Grid 

corresponds to an axis (indicator) in the PCP. A string corresponds to a row (region) in Excel. 
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The PAC has been extended with special features that are important to statistical exploration, such 
as, histograms and filter operations based on percentile statistics. PAC provides the following features: 

 Revealing correlation between indicators; 
 Estimation of degree of similarity between regions; 
 Finding clusters and outliers; 

 Analyze the characteristics of many regions;  
 Picking and highlighting of interesting data items for profile and comparison; 
 Comparison of individual characteristics of a region to the characteristics of all regions; 
 Comparison of indicators associated with a selected region; 
 Comparison of variations of values of different indicators; 
 Dynamic range sliders and statistical methods for defining events such as exceeding of a 

given threshold and identification of outliers; 

 Dynamic visual inquiries, filter operations using familiar statistical methods; 
 Facilitates dynamic animation in linked and coordinated views; 
 

Figure 15 below: Indicator “age group 65+” represented by one PAC axis with minimum value at the bottom 

and maximum at the top. The axis is divided into15 equally sized bars. The length of the bars depends on the 

number of lines (regions) crossing the axis at within the bar. Examples of 1, 3 and 

4 lines crossing are displayed.  

Histograms (figure 15 and 16) attached to each PAC axis are used to 
visualize the distribution of the indicator data values, splitting the axes 
into a user defined number of equally high rectangular areas (bins). A 
coloured region line intersects the PAC axis at a point depending on the 
indicator value and is then sorted into corresponding bin.  The length of a 
rectangle indicates the frequency of regions intersecting that bin, the 
more regions within an area the wider the rectangle. Histograms can be 

turned on/off and the number of bars can be specified 

. Histograms are dynamically moved during a time 
animation and can expose interesting trends over time. 

 
 

 

Figure 16: Three linked views Scatter Plot, a section of the PAC and Selection Information display the same 

information from a different perspective. Two regions Brussels and Oslo are highlighted. 
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Specify indicators to be used in the PAC 

The PAC selects by default the first 5 indicators from the data set. However, 
the choice, number and order among indicators are important.  

The “Set Indicators” button or the Options > Set 

Indicators opens a panel (see left) with all current active indicators. The panel 
shows which indicators are used and their order in the PAC. The user can now 
select indicators to be used in the PAC and select their internal order. 

1: Five indicators (Total Population, Population 0-14 yrs, Population 65+, GDP 
per capita and Tertiary Edu Attainment) are selected for the PAC analyse; 

2: You can change the order of the indicators in the PAC by holding down left 
mouse button and drag the indicator to another position;  

3: Figure 17 shows dragging indicator Tertiary Edu Attainment from its 
previous position into a place after Population 65+ yrs. 

4: The revised order of the PAC indicators are shown here. 

 

 

 

 

 

 

 

 

Figure 17: Changing the order of the selected indicators is achieved by holding down the left mouse button and 

drag the selected indicators to its new position. 

 

Figure 18: We compare four selected regions representing the Nordic countries for seven indicators. By 

assigning different line styles to each region, we can distinguish each region and make comparisons.  We also 

compare them against the Mean value (value) for all regions. The name tags are added automatically. The 

coloured lines in the background are turn off with this slider  in the Settings menu. 
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Visual Inquiries based on dynamic filter operations 

Another advantage with the PAC exploration technique is the capability to dynamically make 
visual inquiries and filter data. Filtering data is a critical step in the process of data analysis. Filter out 
uninteresting regions; reduce the data set to a smaller, more manageable size. Each indicator axis 

has a pair of range sliders which define the bottom and top range for the query area. The range 
of an indicator can be specified by “dragging” the handles on the top and bottom of the 
corresponding range slider (figure 19). Regions with values for a selected indicator, that fall outside of 
the specified range, are filtered out. A combination of range slider movements (figure 19) can be used to 
dynamically formulate a more complex visual inquiry. These visual conditions and constraints will 
immediately reflect the visual contents in all linked views. An example of a query using the sliders is 
shown below. After a dynamic query operation, applied to the indicator "Labour Productivity”, 
regional values below the mean (green line) was removed. A tooltips shows the exact value for the 
slider position along the indicator axis. A second condition is then given for indicator 
“Unemployment rate”, where regions with higher rate (above mean value) are removed. 

 

Figure: Filter operation is performed with range sliders positioned at the top and bottom of each indicator 

axis. Two filter conditions are performed here: 1) Keep regions with high “Labour Productivity” (above mean 

value) AND 2) Keep regions with low “Unemployment Rate” (below mean value). The map to the left shows the 

result after removing the regions that do not fulfil these two conditions. Only regions with yellow-red colours 

remain in the map and all other views. 

Visual Inquiries based on statistical methods 

Using range sliders described above offers control of the data value of the filtering threshold. 
However, it does not return any information on the number of data items removed, and is limited to 
removal of data outside of the range slider. To support visual inquiries using statistical measures a 
novel filtering method based on percentile values has been implemented in the PAC. This statistical 
concept can be used to better facilitate the overview and understanding of data distribution. By 
representing the position of specific percentiles along the axes the user can easily get an 
understanding of the distribution of regions for current indicators. In figure 20, the percentile levels 
and corresponding data value are marked out using tooltips to the right of the percentile slider. 
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Figure 20: The filter operation for “Population age 65+” is here performed with a statistical correct 

operation based on percentiles. Select Option “Percentile”  in the PAC GUI panel (figure 

13). Two percentile sliders marking the 90th and 10th percentiles are displayed for all indicators. By clicking on 

the symbol x between these two markers, all regions between the 10
th

 and 90
th

 percentiles are removed. 

Remaining regions representing the “outliers” are shown in the left map.     

Given a range limited by an upper and a lower percentile value, filter operations can be 
performed either inside or outside of that area by clicking on the removal circle with an inside x 
symbol. This is shown in figure 20 above where all regions between the 10th and 90th percentiles are 
removed (filtered out) by one click. For example, the following conjunctive query: "Find the extreme 
regions for indicator "age 65+" below the 10th and above the 90th percentiles.  

We have adopted a similar percentile calculation in the dynamic colour legend component as 
described previously. 

The icon  is used to switch min and max order along the axis. For example, in figure 
21 below, the indicator “unemployment rate” is regarded to have max value at the bottom (worse 
scenario) while low unemployment rates are placed at the bottom. 

 

Figure 21: The PAC can switch Min and Max along the axis. 

For example, High Unemployment Rate could be placed at the 

bottom of the axis and regions with positive low Unemployment 

will be at the top of the axis. 
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Table lens (extended Histogram) for large tabular data 

 

Figure 24: The Table Lens here with 3 selected indicators and all OECD EU TL2 regions. The first column 

shows the name of the region followed by the selected indicators and their data values (same as a spreadsheet). 

Table Lens is a common information visualization method to dynamically explore large amounts of 
tabular data. Borrowing from the spreadsheet model, the Table Lens displays regional data values in 
columns and rows without scrollbars and without obscuring any data and filling the cells with scaled 
and coloured horizontal small bars. Each row in the Table Lens represents a single region and the 
columns represent a specific indicator. The power of the Table Lens is that it has the combined 
abilities to sort records, focus “zoom” in on interesting areas in the data (to reveal exact numerical 
information) and remove unwanted records. 

The advantage is obtained by using a so-called “focus + context'' or “fisheye'' technique. These 
techniques allow interaction with large information structures by dynamically distorting the spatial 
layout of the structure according to varying interest levels. The relationship between focus and 
context supports searching for patterns in the big picture and dynamically investigating interesting 
details without losing framing context. The most significant feature of a table is the regularity of its 
content with information along rows or columns is consistent. This is reflected in the fact that 
regional tables usually have the name of the region at row and column edges that identify associated 
indicator data values. The Table Lens adjusts the layout of a table without bending any rows or 
columns as illustrated in the figure above. Table Lens can be used to explore patterns in regional 
tables and investigate various explanatory statistics using multivariate dataset. 

The following interactive features are supported: 

o Sort by clicking on columns. 

o Rearrange indicator columns by dragging-and-dropping in a GUI table panel. 

o Focus by clicking on a cell or by clicking and dragging to focus a whole row or multiple rows. 

o Filter regions to create smaller, more specific datasets. 

o Spotlight data to track particular information as you sort. 
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To sort the regions in the Table Lens simply click on the header of the column that you want to 
sort by, clicking multiple times on the same header will reverse the order of the records. 

The zoom capabilities in the Table Lens work by clicking and dragging with the mouse. To select 
an area to zoom in on click and hold the left mouse button on the record that you want the 
area to start with. Then drag the mouse downwards until the regions of interest is covered by 
the light blue rectangle that appears when you start to drag, to complete the selection release 
the mouse button. The selected regions will be enlarged to reveal exact numerical values as 
well as the horizontal bar representation. 

To deselect an area of regions click and hold the left mouse button on the regions that you 
want the area to start with and then drag upwards instead of downwards, the records covered 
by the rectangle will be deselected. You can also use the button labelled "Reset selection" in 
the settings panel located beneath the Table Lens component to deselect all records. The Table 
Lens can also be used to filter away unwanted records from the data set, this is done by first 
selecting the regions that should be removed followed by clicking the button labelled "Filter 
away selected" in the Table Lens settings panel. This can be done repeatedly. To reset this filter 
click the button labelled "Reset selection" in the Table Lens settings panel. 

 

Figure 25: The regions in the Table lens are sorted after the fifth indicator column “Tertiary Education”. Only 

regions with highest education value are shown using the “Filter Away” operation. 
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Time Animation with Statistics eXplorer motion graphs 

 
Figure 26: Statistics eXplorer motion graphs. All graphs are connected to the same data cube model and 

updated simultaneously.  

Statistics eXplorer employs a novel data model (figure 26) optimized for handling spatial-temporal 
and multivariate indicator data sets in a GeoAnalytics context. This conceptual data model can be 
seen as a data cube with three dimensions: space, time and attributes. The spatial dimension is here 
represented by the OECD territorial levels (TL2 or TL3), while the attributes dimension is represented 
by the indicators, and the time dimension is represented by the value of the indicators in each period 
of time. The general method for finding a value in the cube is by its position [space; time; attribute;]. 

 

Figure 27: Data cube model applied in OECD eXplorer. 

Space-time-indicator awareness means that the data cube can be analysed and visualized across 
all three dimensions simultaneously. Statistics eXplorer performs this task by integrating and time-
linking three visual representation views: choropleth map, PAC and scatter plot (bubble). The bubble 
plot is demonstrated to be an effective Flash-based time animation method, but integrated and 
linked with a choropleth map and a multivariate indicator frequency histogram embedded in a PAC, 
makes it even more useful. The Statistics eXplorer open architecture, handling of large datasets and 
integrated Story mechanism are other important extensions to this emerging animation technique. 
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Time animation step-by-step 

1) Indicator > Load Data>Select “Time span” (available indicators with time step data is displayed); 

2) Select “Minimize time span” or “maximize time span” and years to focus on; 

3) Select the indicators to be analysed; the (i)  icon has Meta information about the indicator and 
the time icon  shows the available time periods; Click Load; 

 

4) The Map and Scatter Plot views are displayed together with a Time slider panel;  

5) Select Indicator “65+ “ for colour mapping; Select Indicator “0-14” and “65+” for Scatter Plot 
axes, select “Total population” for dot size. 

6) A default colour scale is for a time animation calculated linearly from the Min (2.22) and Max 
(26.51) values for Indicator “65+”. The default calculated class values are not suitable for this 
time animation. First, another colour map is selected (4th from the top with discrete colour 
steps). User defined class values (10, 14, 17, 20 and 24) are set by moving the dynamic handler 
along the colour legend or by a double click on the class value resulting in a popup panel where 
a class value can be written. See figure 30. 

7) It’s difficult to analyse time animation when all dots are moving. Select interesting regions to be 
highlighted during the animation. Four regions are highlighted in this time animation (figure 27). 

 

8) Now, start moving the time slider (c) by hand or (a) automatically. The current time step is 
updated (d) and in the Scatter Plot background. (b) sets the automatic animation speed. 

9) You can now easily follow the movements of the selected regions and also see the name 
attached to these regions. A trace is displayed following the movement of selected regions. 

10) When the last time step 2005 is on, you can select any region and see their corresponding time 
trace for 1995-2005 without moving the time slider. 
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Figure 28: For the last time step – you can highlight any region and see a trace that represents the time 

movement. Here, two regions are highlighted for time step 2005. 

 

Figure 29: For time animation, a default (percentile method) colour scale is calculated for the selected Indicator 

covering all time steps. An alternative colour map is here also selected. User defined class values are specified 

by moving the dynamic handlers or by a double click on the class value to be changed and write the new value in 

the popup panel. 
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Time animation in Scatter Plot 

If the selected indicators represents time varying data then the selected dots will move over the 
Scatter Plot and highlighted regions will also leave a trail (figure 30) when moving the time slider. You 
can easily see how highlighted regions perform over time. 

 

Figure 30a: Time animation for “fertility rate” vs. “age group 0-14” during 1960-2008 in Scatter Plot. Four 

regions are highlighted Nigeria, Mexico, USA and Italy. Their traces show movements during 1960-2008. 

Figure 30b: Time animation for a zoomed part of the whole world with focus on countries USA, France and 

Italy with low fertility rates. 
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Data Grid View 

The Data Grid view corresponds to an Excel Sheet where all regional data values are displayed. 
Each row represents a region and the columns are the selected indicators. Only active regions are 
displayed. Regions removed by a filtering operation (e.g. colour legend filter slider or the PAC) are 
not shown in the Data Grid. Regional names and values of indicators can be sorted by clicking on the 
header. The order of the columns is described in figure 32. 

 

Figure 31a: Data Grid where column “GDP per capita” is sorted (click on the header) after ascending 

order. Oslo is highlighted representing the third highest GDP per capita region in EU. 

 

Figure 31b: Data Grid after a filter operation applied in colour legend. Regions with high “Unemployment” 

are in focus after a linear filter operation has removed all regions with an unemployment rate below 15.50%. 

German region Second highest unemployment region Mecklenburg-Vorpommern is highlighted. 
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Organize the Indicators in columns 

 

 

Figure 32a, b and c: The Indicator columns are assigned through Options > Set Indicators and can be 

organized in any order. The assigned order affects Data Grid, Table Lens and Parallel Axes methods. The 

default order is shown in (b) and an example of dragging an indicator into a new position in (c). 

There are three views that have a 
similar behaviour visualizing 
multivariate indicator data: Data Grid, 
Table lens and Parallel Axes Chart. Each 
method is based on column-oriented 
visualization. The user can organize the 
indicators in the Options > Set 

Indicators panel. See also figure 16.
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Export high resolution images for documents  

The simplest way to save the views provided by the Statistics eXplorer is by taking a screenshot. A 
screenshot is an image taken by the computer including all the visible items in the screen. To take a 
screenshot: 

1) Maximize the window where the Statistics eXplorer is running; 
2) Turn on the “Full screen” option of the web browser to hide the navigation bar. In both 

Windows OECD eXplorer and Mozilla Firefox, this can be done by selecting View > Full 
screen; 

3) Once the window is fully opened, press the “Print Screen / SysRq” key to take the 
screenshot; 

4) The image can now be pasted into a Word or PowerPoint document by clicking the right 
mouse button and selecting the “Paste” option (or by pressing “Ctrl + V”). 

A screenshot includes all the active views in the Statistics eXplorer. To capture a particular view, 
the rest of the views must be inactive. For instance, to capture the map view (below), the scatter plot 
and the story telling views have been switched off using the View menu in the top bar of the 
Statistics eXplorer. 

Exporting higher resolution images into PNG or JPG formats 

If a special higher resolution image is required for e.g. document printing then use Options > Export 

Image. An image with 200 dpi or higher is produced in ping or jpeg format and is saved into a file. Only the map 

view and bottom view can be used to export an image. The colour legend box version is used here and included 

in the exported image. 

Figure 33: High resolution image of the current map view is exported and saved into a file PNG. Note, Google 

Map cannot be included when exporting images. The new V3.7 colour legend is included. 

  



35 

 

Storytelling 

 

Figure 34: The analyst uses Statistics eXplorer to1) import regional statistical data, 2) explore and make 

discoveries through trends and patterns and derive insight - gained knowledge is the foundation for 3) creating a 

story that can be 4) shared with colleagues and reach consensus and trust. The visual discoveries are captured 

into snapshots together with descriptive metadata and hyperlinks in relation to the analytics reasoning. The 

author gets feedback from colleagues, adopts the story.  5) An optional OECD eXplorer Publisher can then 

publish “tell-a-story” to the community using a “Vislet” that is embedded in your web page or a blog. 

Complex and collaborative geovisual analytics sense-making tasks require the external 
representation and visual organization of information. These methods could help users to compare, 
organize, comprehend and reflect on what they know, to quickly access specific information when 
needed, to remember relevant thoughts and ideas, as well as to exchange knowledge and develop a 
shared understanding with other people. Computer generated information visualizations usually 
explicitly state relationships among information items thus allowing for quick and non-ambiguous 
explorations of an information space. Human generated information arrangements are often vague 
in regards to relationships thus inviting more creative interpretations of an information space. The 
Statistics eXplorer Framework integrates tools for both collaborative interactive visualization and 
sense-making. A story indicates a successful suggestion and subsequently fosters additional 
suggestions based on similar considerations. This learning mechanism allows our storytelling system 
to improve the accuracy of its suggestions as well as to dynamically adapt to particular users, tasks 
and circumstances. Colleagues can review a story arrangement and respond with suggestions and 
comments and subsequently fosters additional suggestions based on similar considerations. 
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Figure 35: Example of a geovisual analytics time animation discovery that was captured and saved as a story 

called “Ageing Population in OECD EU TL2 regions 1990-2008”. This story is once more opened and 

explained. The colour indicator represents "elderly dependency rate". Two regions, Liguria and Toscana (Italy), 

have the highest “population 65+” and are highlighted in both views. The scatter plot shows a correlation 

between "age group 65+ yrs" and "age group 15-64 yrs". The Story (right panel) shows the metatext for current 

story and a list of associated stories. 

Statistics eXplorer facilitates the architecture to support means of capture, add descriptive text, 
save, packaging and sharing the discovery and results of a geovisual analytics process in a series of 
snapshots to create a “Story” (figure 34 and 36). When the button “Capture” in the Story Editor is 
pressed, the state of each view (figure 37) in Statistics eXplorer is saved together with user-defined 
metatext. Before closing the application, the user exports the story into a XML formatted file. Team 
members can through descriptive text combined with interactive visualization follow the analyst’s 
way of logical reasoning by loading selected stories. At any time a team member can access stories 
and apply them in Statistics eXplorer. A comprehensive story in the context of a remote 
collaborative sense-making activity can thus be created by the analyst through a set of linked 
snapshots. Users will discuss relevant issues through storytelling based on solid evidence, thus raising 
awareness and increasing the common knowledge on a certain phenomenon. 

Figure 36: Storytelling step-by-step. 
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Storytelling step-by-step 

5) During an OECD eXplorer session, the analyst first selects data to be analysed and associate 
attributes. Search for trends, outliers, discovers important observations, highlights data items 
to be compared etc. - a discovery is made; 

6) Open the Story Panel (right view) if the panel is not already open. 
7)  Create a Story, a Story Editor panel comes up; 
8) Press Capture! The entire Statistics eXplorer session with data, views, highlights, zoom etc 

are saved; 
9) Fill in the required information and associate meta or reasoning text; 
10) Add hyperlinks (see chapter below) in the metatext that link to an external web site or 

another discovery; 
11) (The user can now start a new Chapter in the Story with new Indicators and create a new 

scenario and repeat the process above by pressing the button “New” in the Chapter panel;) 
12) When the Story is completed then press Close; 
13) Use the button Export, give the Story a name "my story nr 2".xml. REMEMBER the prefix 

.xml!  
14) The Story is now saved locally on your computer and can be reused Import or sent to a 

colleague for review in Statistics eXplorer. 
 

 
 
Figure 37: Storytelling using hyperlinks linked to Statistics eXplorer snapshots. 
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Hyperlinks in Story Telling 

A Statistics eXplorer story hyperlink is a 
reference in the story metatext to an external web 
site or another OECD eXplorer discovery (view). A 
text item in the current story is highlighted so that 
when clicked, the story automatically displays in 
Statistics eXplorer, for example, a zoom to a 
certain region, change of indicator etc. or shows 
some referenced external content. This 
highlighted word(s) is known as a hyperlink and 
makes a logical connection to an Statistics 
eXplorer state or external reference. Hyperlinks 
are the basic building block of hypertexts. For 
example, some key words in a story such as Italy 
are highlighted, and provide links to explanations 
of those words in the same Statistics eXplorer 
story. 

To insert a hyperlink in the metatext that links 
to a snapshot or an external URL is often simply 
called to "link". Hypertext (meaning "more than 

just text") is a form of text that provides a richer functionality than simple metatext by allowing the 
reader to learn about topics within the story by clicking on key words. Typically the link anchor will 
be descriptive of the target's content (e.g. Italy), for example a NCVA blog. 

Highlight the text to become a Hypertext, choose New Capture or External URL. PRESS Capture to 
save the present Statistics eXplorer snapshot.  When the Hypertext is initiated, Statistics eXplorer 
will display the state-of-the-snapshot. 

 

 

 

 

 

 

 

 

 

 

 

For more detailed information see http://ncva.itn.liu.se and eXplorer 

When the hypertext 
London is pressed the 
corresponding saved 
Snapshot is instantiated 
and the map zoom in on 
London and the 
corresponding bubble in 
Scatter Plot is marked. 

http://ncvademo-mobile.blogspot.se/

